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Plus (Ver. 4.0)
m Data Storage and Memory

y\Take Off (Page no. 11)

@

(:: ! Double Tap (Page no. 13)

1. Memory

2. Permanent

3. Pen Drive

g Choose the correct option.

1. b. 2. a. 3.c 4.d.

@ Fill in the blanks with the correct words.

1. USB 2. Byte 3. Hard disk 4. Zettabyte
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) Answer the following questions:

1. The storage space in a computer is called memory.

Secondary memory is permanent in nature and is not directly accessed by the CPU. It allows
users to store data that may be easily retrieved.

3. Hard disk is permanently fixed in the CPU Box. The most important function of the hard disk is
to store program files and data files.

Pen drive is a portable storage device and is easy to use as it is small and can be carried in a
pocket and plugged into any computer with a USB drive.

4. RAMis a temporary memory. The information stored in this memory is lost when the computer is
turned off. That's why it is also called volatile memory whereas ROM is the permanent memory,
i.e. it holds the data even if the system is switched off. It holds the starting instructions that are
required to start a computer. It is also called non-volatile memory.

@ Scratch Your Brain.

Hard Disk Compact Disk Pen Drive Memory Card

2. | Competency-based/Application-based questions:

a. Memory Card
b. (iii)

mMa_naging Files and Folders in Windows 10
y\Take Off (Page no. 18)
1 2.

3. 4.
il Q
Hl
Folder Start Button Recycle Bin
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@&uble Tap (Page no. 22)

1. b. 2. d. 3. a. 4. c.

Choose the correct option.

1. d. 2. a. 3. b. 4. a.

@ Fill in the blanks with the correct words.

1. Live 2. This PC 3. Icon 4. Thumbnail

pA Tick (v') the correct statements and cross (x) the wrong ones.

1.x 2.V 3.V 4. v

w:) Answer the following questions:

1. There are two panes. In the left pane it displays an alphabetical list of all the programs installed
on your computer. In the right pane it contains tiles.

2. Afolder is like a file cabinet in which you can keep your files. In other words, a folder is a collection
of files..

3. Step 1: Open File Explorer and browse to the location where you want to create a new folder.
Step 2: Click on the Home tab.
Step 3: Click on the New folder option.
Step 4: Type the name of the New folder and press the Enter key.

4. Afile is a collection of data and information, stored on a storage device such as hard disk, pen
drive, CD/ DVD.

Step 1: Browse to the location of the file or folder you want to move.

Step 2: Select the file or folder to be moved.

Step 3: Click on Home tab.

Step 4: Click on Cut command.

Step 5: Select the destination location where you want to move the file or folder.
Step 6: Click on Paste command.
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@ Scratch Your Brain.

1. a. Window key + E
b. Select file/ folder then press F2
c. Ctrl + C
d. Ctrl +V
e. CTRL+Shift+N

2. | Competency-based/Application-based questions:
a. Recycle Bin

b. Start, Live

R vore on word 2019
y\Take Off (Page no. 31)

Do it yourself

(:: ! Double Tap (Page no. 38)

1. b. 2.¢c 3.d. 4. a.

Choose the correct option.

l.c 2.d. 3.d. 4. a.

@ Fill in the blanks with the correct words.

1. Columns 2. This Device 3. Insert 4. Merge Cells

pA Tick (v') the correct statements and cross (x) the wrong ones.

1. x 2.V 3.x 4. x 5.x%
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) Answer the following questions:

1. The Shapes command is used to draw shapes, it has different categories of shapes, like Lines,
Rectangles, Basic Shapes, Block Arrows, Flowchart, Stars and Banners, and Callouts.

2. WordArt is a special effect in Word to change the appearance of the text and make it look attractive.
3. Step 1: Click on the Insert tab.

Step 2: Click on the drop-down arrow and select Online Pictures option.

Step 3: Type the name of image that you want to search in Bing Image Search box.

Step 4: Select the picture you want to insert.

Step 5: Click on the Insert (1) button.
4. Step 1: Select the rows or columns which you want to delete from the table.

Step 2: Click on Layout tab.

Step 3: Click on Delete drop-down arrow.

Step 4: Select the desired option.

@ Scratch Your Brain.

1. a.Top Left alignment
b. Top Center alignment
c. Top Right alignment
2. Competency-based/Application-based questions:
a. Step 1: Click on the Insert tab.
Step 2: Click on WordArt option.
Step 3: Choose the desired style.
Step 4: Type the desired text in the text box and click outside it.
b. Insert tab, Pictures command

Periodic Assessment-1

(Based on chapters 1 to 3)

A. 1. MEMORY 2. FOLDER 3. FILE EXPLORER
4. RECYCLE BIN 5. COMPACT DISC

B. 1.Table 2. Delete a Table 3. Word File 4. RAM 5. Folder
6. ROM 7. Memory Card 8. Music File

C. 1. File 2. Start Menu 3. This PC 4. Recycle Bin 5. Taskbar
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mmt_roduction to PowerPoint 2019
y\Take Off (Page no. 46)

Do it yourself.

@ﬂble Tap (Page no. 50)

1. Control Button
2. Text Placeholder
3. Speaker’s Notes Pane

@ﬂble Tap (Page no. 55)

LF 2.7 3.T 4.7

©3) Choose the correct option.

1 a 2.d. 3. b 4.d.
@ Fill in the blanks with the correct words.

1. Backstage 2. Title bar 3. Slide Show 4. Slide area 5. Insert

@ Match the following:

l.c 2. e 3.d. 4. a. 5. b.

VA Tick (v') the correct statements and cross (x) the wrong ones.

1. x 2.V 3.x 4, x 5. x

&) Answer the following questions:

1. A single page of the presentation is called a slide.
2. Four components of PowerPoint window are: Title bar, Control button, Ribbon, Placeholder.

' Plus (Ver. 4011V (Answer Key) :<<<<<<<<<<<<<<<




3. A slide layout is the formatting and positioning of the placeholder boxes for the content that
appears on a slide. There are Nine slide layouts available in Power Point.

4. Slide Sorter View
a. It shows the miniature version of all slides.

b. The advantage of this view is that you can see more number of slides on the screen and you
can move, delete, edit and recognise these slides with greater ease.

Reading View

a. Itis used when you want to view a presentation not in full screen but in a window with simple
controls that make the presentation easy to review.

b. The ribbon and the Slides/Outline pane are not visible.
5. Step 1: Click on the Insert tab.
Step 2: Select SmartArt option.
Step 3: Choose desired category.
Step 4: Choose a graphic layout.
Step 5: Click on the OK button.
Step 6: Click on [Text] in each individual shape and type the desired text.

@ Scratch Your Brain.

1. a. SLIDE b. PRESENTATION c. BACKSTAGE
d. PLACEHOLDER e. SMARTART

2. | Competency-based/Application-based questions:
a. Themes
b. Abhilaksh can insert SmartArt.

IR usine 2 Browser
y\Take Off (Page no. 62)

1. Search information @
2. Chat online @ 6. Take a bath

5. Send and receive e-mail

3. Sleep 7. Watch a cartoon movie

OWOV

4. Buy a mobile phone @ 8. Pack your bag
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@&uble Tap (Page no. 64)

1. Refresh 2. New Tab 3. Microsoft Edge 4. Favourites

@3 Choose the correct option.

1 b. 2. d. 3. ¢ 4. b.

@ Fill in the blanks with the correct words.

1. Internet 2. Microsoft Edge 3. Home page 4. Refresh

VA Tick (v') the correct statements and cross (x) the wrong ones.

1. v 2. % 3. x 4.v

3») Answer the following questions:

1. It is a software application for accessing information on the World Wide Web (WWW). 1t is also
referred to as W3 or web.

2. Downloading is the process of transferring data from a server to a client's computer (the user’s
computer through the internet), whereas Uploading is the process of moving data from your
computer (client's computer) to a server through the Internet.

3. Microsoft Edge is the default web browser in the Windows 10 operating system. Current Tab,
Address Bar, New Tab.

@ Scratch Your Brain.

1. Do it yourself.

2. | Competency-based/Application-based questions:
a. Voice search
b. Address bar

5
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Periodic Assessment-2

(Based on chapters 4 & 5)

A. 1. Slide Layout
2. Speaker’'s notes pane
3. Reading view
4. Backstage

B. _ Quick Access Toolbar T ~ Control buttons |

~ Slides/Outline . Click to add title

pane Click to add subtitle

Side 1o ZNotes Wcomments | [0 32 B T - —4—~——- &% 3

. | Speaker's Notes pane Placeholder |

C. 1V 2.x 3.V 4.v

Test Sheet-1

(Based on chapters 1 to 5)
lc 2.a. 3. b. 4. b. 5.c 6. a.
7.d. 8.c. 9. b. 10. a. 11. b. 12.d.
1. Columns 2. Live 3. File Explorer 4. Insert 5. Slide Show 6. Refresh
1. x 2.% 3. x 4.v
1 d. 2. ¢ 3. a 4. b.
1. A collection of related files is called a folder.
2
3
4
5

mpoD wm W

. The intersection of a row and a column called Cell.

. A single page of the presentation is called a slide.

. Four components of PowerPoint window are: Title bar, Control button, Ribbon, Placeholder.
. WordArt is a special effect in Word to change the appearance of the text.

Y
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6. The steps to change the row height in a table are:
a. Select the rows or columns.
b. Click on Layout tab.
¢. Change the height and width of cells from the Height and Width Scroll box.

7. Primary memory is the main memory of a computer. CPU can directly access this memory. It
is fixed on the motherboard of a computer. Primary memory is further divided into two types:

1. Random Access Memory (RAM)
2. Read Only Memory (ROM)

8. Slide layout is the formatting and positioning of the placeholder boxes for the content
that appears on a slide. Their are Nine Slide layout Title Slide,Title and Content, Section
Header, Two Content, Comparison,Title Only, Blank,Content with Caption, and Picture
with Caption.

y\Take Off (Page no. 76)
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Mble Tap (Page no. 79)

g Choose the correct option.

1.d. 2. a. 3. a.

) Answer the following questions:

1. Picture Puzzle is a type of visual activity that involve a series of pictures that are interpreted.

2. When a shape looks exactly the same to its original shape after being flipped or turned, it is
called a mirror image.

@ Scratch Your Brain.

1. Do it yourself

>>>>>>>>>>>>>>> Plus (Ver. 4.0)-IV (Answer Key) 1



More Blocks in Scratch
y\Take Off (Page no. 83)

-
A A

e
=] =]
(::! Double Tap (Page no. 85)

ON - D - ©

of-"'©-0—

@ =l You can speak owl language? Rig o seconds

@ =V Viho's there? lnrom

@3 Choose the correct option.

1. a. 2.d. 3.a. 4. a.

@ Fill in the blanks with the correct words.

1. Say 2.Go to 3. Sound 4. Move
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VA Tick (v') the correct statements and cross (x) the wrong ones.

1 x 2.V 3. x 4. x

) Answer the following questions:

1. Two components of Scratch screen are: Stage area, Backdrop.

2. The nine main block categories in Scratch are: Motion, Looks, Sound, Events, Control, Sensing,
Operators, Variables, My Blocks.

3. The blocks that are used to control how the blocks in a script will start to run if a particular action
is done are known as Events blocks.

4. The sprite’s position is determined when the stage is divided into different values of x and y.
Each dot on the stage is made up of both x and y values. The value of x gives the horizontal
(left to right) location of the sprite. The value of y gives the vertical (top-to-bottom) location
of the sprite.

@ Scratch Your Brain.

L XIs|eE|IN|s|I1|N|G]O M| O
clrlvlolr|elr|alr]o]|r]s
tlv]eleln]z]ulr|[T]1|r]|T]O
ilsle|n|r]x]tlilololk|s]u
ole|B|T|Oo|R|O|W|R|A|[W|R]|N
Nlalols m]ulrl]c]le|L D
clo|N|T|R|O|L|G|L|P|Q|M|Z

2. | Competency-based/Application-based questions:
a. Sound Blocks
b. Neha can use the go to x: [value] y: [value] block.
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mCLating Shapes in Scratch
y\Take Off (Page no. 92)

1. Sprite 2. Stop button 3. Backdrop

(:: ! Double Tap (Page no. 94)

1. Heptagon 2. Triangle 3. Pentagon 4. Nonagon
5. Hexagon 6. Octagon

Choose the correct option.

1 b 2. ¢ 3. c

@ Fill in the blanks with the correct words.

1. Polygon 2. 360 3.Go 4. Hexagon

) Answer the following questions:

1. The Pen blocks are green in colour. Pen block is used to draw a trail as the sprite moves on the
stage .You can change the colour of the pen.

2. There are eight sides of an octagon. The turn angle of an octagon is 360/8=45 degree.

3.

-

@ Scratch Your Brain.

1. a.Sides 3
Degree 120
b. Sides 4
Degree 90
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c. Sides 5
Degree 72
d. Sides 6
Degree 60
2. | Competency-based/Application-based questions:
a. She can use Stamp Block
b. Repeat 9 Move 100 steps Turn 40 degrees

Periodic Assessment-3

(Based on chapters 6 to 8)
A. Do it yourself

C. a. This block will set the pen colour, saturation, brightness and transparency to the given value.

b. This block creates a duplicate of the current sprite. To see the image, click on the sprite and
drag.

c. This block changes the pen colour, saturation, brightness and transparency.

A coogte Biockdy Games
y\Take Off (Page no. 100)

Move the object in the forward direction from the direction it is facing.
2. Turn the object in the left direction from the direction it is facing.

@ﬂble Tap (Page no. 100)

W heacing €53 R cocs not have worn [RREERT RPN

@3 Choose the correct option.

1. b. 2. c 3. b. 4. b.
£
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@ Fill in the blanks with the correct words. I
1. Turtle 2. Loops 3. Turn...by 4. Run Program
VA Tick (v') the correct statements and cross (x) the wrong ones.

1. v 2.V 3. x 4.v

2 ») Answer the following questions:

1. Heading Block
If do else Block

2. If the bird does not reach to the desalination then run program button will change in to Reset
button and to do it again click on the reset button.

repeat KB times
do | move by
Lﬂm\ L90° - |

Step 1: Drag the following blocks and change required value to draw a square.
Step 2: Click on Run Program button.

@ Scratch Your Brain.

1. a. This block turns the object in the left direction from the direction it is facing.

b. This block allows the bird to fly in one direction till the condition is true, and it changes
direction when the condition becomes false.

2. | Competency-based/Application-based questions:
a. (i)

b. Turtle Game

@"3
=D
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y\Take Off (Page no. 108)

1. Smartphone 2. Smartwatch 3. Smart Speaker

Mble Tap (Pageno. 111)

1. WABOT 2. ASIMO

©§) Choose the correct option.

1. a. 2. b. 3. d. 4. a.

VA Tick (v') the correct statements and cross (x) the wrong ones.

1. x 2.V 3. x 4. x

g :) Answer the following questions:

1. Artificial Intelligence is the ability of a machine to think and learn.

In 1950, Alan Turing submitted a paper about the possibility of creating machine that would
think. This became a test for machines to check their thinking capability. One of the greatest
achievements of Alan Turing is the creation of Bombe, a machine that could decode encoded
messages.

3. Roomba, an autonomous robot vacuum cleaner that cleans and is able to avoid crashing into
obstacles.

4. In 2016, David Hanson created a humanoid named Sophia. She can copy human gestures and
facial expressions.

@ Scratch Your Brain.

1. a. ALAN TURING b. WABOT c. ROOMBA
d. SOPHIA e. CORTANA

2. | Competency-based/Application-based questions:
a. (iii)

b. Swara should gift him a virtual assistant like Alexa or Cortana.

)20 P Vor 400V (arswr o) 17



A. 1. This block turns the object in the left direction from the direction it is facing.

2. This block allows the bird to fly in one direction till the condition is true, and it changes direction
when the condition becomes false.

3. The condition allows the bird to move in the direction in do section of the block till the
condition is true otherwise move in the direction in the else section of the block when the
condition becomes false.

4. The move...by block is used to make the turtle move the forward or backward to draw the
shape.

5. The repeat...times do block to make the turtle repeat tasks given inside the block for given
number of times.

B. 1.iii. 2.1 3.v. 4. ii. 5.iv.
Test Sheet-2
(Based on chapters 6 to 10)
A. 1.d 2.d. 3. a 4. a. 5.c

6. b. 7.b. 8. a. 9.a. 10. a.

11. b. 12. b.

B. 1.John McCarthy 2. Polygon 3.360 4.Goto 5. Bombe
C. 1LV 2. x 3.V 4.v

D. 1.c 2.a. 3.d. 4. b.

E. 1. Artificial Intelligence is the ability of a machine to think and learn.

2.1n 1950, Alan Turing submitted a paper about the possibility of creating machine that would
think. This became a test for machines to check their thinking capability. One of the greatest
achievements of Alan Turing is the creation of Bombe, a machine that could decode encoded
messages.

3. Visual Processing

4. Control Block

5. Pen block is used to draw a trail as the sprite moves on the stage .You can change the colour
of the pen.

6. To draw a square we can keep the value of the move block same but to draw a rectangle there
will be 2 different values for the move block since there are two different values for sides of
rectangle i.e., length and breadth.

7. When a shape looks exactly the same to its original shape after being flipped or turned, it is
called a mirror image.

8. If the bird does not reach to the desalination then run program button will change in to Reset
button and to do it again click on the reset button.

|
78 Plus (Ver. 4011V (Answer Key) '<<<<<<<<<<<<<

Periodic Assessment—4
(Based on chapters 9 & 10)



